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Training Script for Project Hope  
Train the Trainer 

A WinstonNet Endeavor 
Part II  

Outlook (Email, Contacts, Calendar), Instant Messaging (AIM and MSN), More Microsoft Word 
 
 
Outlook E-mail, Contacts, Calendar 
 
Who has used e-mail before? What can you tell me about it? 
It’s an easy way to stay in touch with people. It’s just like regular mail, without the 
stamps! 
 
** You may also check your email online at http://www.winstonnet.org/webmail 
 
To write and send an email 
Your new email address is firstname.lastname@winstonnet.org 
Ask the students what their email address is to ensure understanding. Ask them what 
each other’s email address is. 
 
Have them open Outlook by double-clicking on the icon on the Desktop. 
Let’s write and send an email together: 

1. Click the envelope icon at the top of the screen that reads “New.” 
2. In the box next to To: type the e-mail address of someone else in training. 

Everyone type the email address of someone here now. Make sure everyone will 
be receiving a message. This is very important for the next step. Maybe ask 
“Who’s sending an email to _______?” for every student. 

3. Subject: write a subject line that the person will see when they receive your 
message. 

4. In the large box at the bottom, type your message. How about “hello from 
computer training. This is a new email address at Project HOPE”. 

5. When you are finished, press the Send button in the top left corner. This will 
send your email. 

 
Check your email to see if you have received any messages. 

1. Click on the Inbox icon on the left side of the screen (in the ‘Outlook Shortcuts’ 
menu).  Think of your inbox as your own personal mailbox.  This is where your 
email messages are delivered. 

2. You will now see a split screen.  The top half lists all the messages in your Inbox 
and the bottom half displays the text of each message. 

 
Next, we’re going to reply to an email.  

1. Click on the message in your Inbox that you just received. 
2. Click Reply on the top toolbar. 
3. Type your reply in the box at the bottom. How about “thanks for the email!” 
4. Then press Send. 

 
Questions? 
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What if you want to send an email that you received to another person? This is called 
Forwarding and you use the Forward button. 

1. Click on the message in your Inbox that you want to forward. 
2. Click Forward on the top toolbar. 
3. In the box next to To: type the e-mail address of the person you’d like to forward 

the message to.  Let’s choose someone else in the class. Again, make sure that 
everyone will be receiving a message. 

4. Then type a note about the message you are forwarding. How about “I thought 
you would like this email, so I’m sending it to you.” 

5. When you are finished, press the Send button in the top left corner. 
 
Did you know that you can send a file with an email message? It’s like writing someone 
a note and paper-clipping it to an article you thought they would like to read and sending 
it in an envelope. If you want to send someone a file with an email, it’s called an 
attachment. 
Let’s send one now by replying to the forwarded message: 
 

1. Click on the reply button. 
2. Type “Here’s the file I told you about” 
3. Click the paper clip icon in the toolbar at the top of the window. 
4. This will open your personal folder on the server. Click one of the documents (not 

a folder), and click Insert. 
5. Then, send your message. 

 
So if someone sends you an attachment, how do you open it? 

1. In the message, look for the word Attachments 
2. Double-click on the filename next to it. 
3. You will be prompted to either open the file, or save it. Always choose to save it, 

so you can make changes to it later. It will prompt you to save the file to your 
personal directory. 

4. Then, you can view the attachment by going to your directory. Who can tell me 
how to get there? 

 
A few words about email and attachments: 
Advertisements, called SPAM, will be sent to your address. It’s just like junk mail that 
comes in the regular mail. Trash it. 
Sometimes viruses and other files are sent as attachments. If you receive a suspicious 
email, even from someone you know, don’t open the attachment. Try to verify that they 
sent it to you 
 
Also, be careful about the information you give out via email. Never send credit card 
information or other personal information via email. You may not always know who’s on 
the other end. 
 
One last helpful suggestion for email: Folders 
We all get a lot of email, and it can get overwhelming. It’s a good idea to keep it 
organized with folders. That way, you inbox doesn’t get filled up, and you know where 
certain messages are located if you need them. 
 
To create a folder: 
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1. First, we need to be able to see the folders, so click on View in the main menu 
and then Folder List. This will show you your folders. 

2. Right-click on Outlook Today in the list and choose New Folder. 
3. Give the folder a helpful name so you’ll know what’s in it. 
4. Make sure it will place the folder in your mailbox and click OK. 
5. If a prompt opens about a shortcut, have them say no and check the box so it 

doesn’t ask them again. 
 
Next, let’s move an email message into the folder. 
Click and drag one of the messages you have received to the folder. 
 
Deleting old and unwanted messages is also a good idea.  To do this: 

1. Click on the message you want to delete. 
2. Then either hit the Delete  key or right click on the message and select Delete . 

 
 
Questions? 
 
Outlook Contacts 
This is like an address book. You can keep information like phone numbers, addresses, 
email addresses, etc. 
To create  a new contact entry: 

1. Open the contacts list by click on Contacts in the list on the left. 
2. Double-click anywhere in the blank space to create a contact.  
3. Create one now by filling in the text boxes with all the relevant information.  Press 

Save when you are done. 
 
To open the contact information of a person, just double-click their entry. Try that now. 
 
You can also make a contact entry from an email you receive: 

1. Open your Inbox again.  
2. Double-click on the person’s name that is listed after the From: field. 
3. This will open information about that person. Click the button labeled Add to 

Personal Address Book. This will open a new contact entry with that person’s 
information.  

4. Add any information you want to it. 
5. Press Save and Close   

 
Let’s go back into the address book and see if it added the entry. 
 
You can also use the contacts list to send someone an email. Just right-click on the 
entry and select New Message to Contact. 
 
Outlook Calendar 
There is a calendar program in Outlook. You access it by clicking on it in the menu on 
the left. 
You can add appointments by double-clicking on the appropriate times. 
 
Questions? 
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AOL and MSN Instant Messenger 
 
How many of you have used an instant messaging program before? Pretty easy, right? 
They are used to have conversations in real time over the Internet. 
There are two types of messaging programs installed on the computers, AOL and MSN. 
We are only going to talk about MSN’s today. 
 
MSN 
To load MSN, just go to Start, Programs, MSN Messenger.  
But how do you know who’s available to chat? 
You can keep a list of your friends.  
To add your friends, just click on Add a contact. 
It will prompt you for their name. Let’s all add the WinstonNet Help Desk. 
This way, if you need computer help, you can IM them. 

1. Click Add a contact.  
2. Click the button beside Search for a Contact then Next. 
3. Type the word “help” in the first name box and click Next. 
4. Click Next to select the Help Desk. 
5. Click Finish. 

 
Let’s also add the person next to you, right now.  You can add them by name or email 
address. 
 
To send a message to someone, you just double-click their name in the program. 
Try sending a message to the person next to you.  Type your message in the bottom half 
of the window.  The top half will display the text of your conversation. 
 
AOL’s instant messenger program works very similar, so feel free to use that as well. 
 
Questions? 
 
In-Depth MS Word 
We talked a little about Microsoft Word last time. Let’s go over some more advanced 
topics today. Open up Microsoft Word. 
 
Go to your home directory and open the file you created last time.  We are now going to 
do some text manipulation by using different fonts, colors, sizes, bold, italics, and 
underline. 
 
Changing the font and size: 

1. Highlight your first sentence (remember – you can highlight by clicking at the 
beginning of the text and dragging your mouse to the end of the text, holding the 
left button the whole time or holding down the shift key and using the arrow 
keys).   

2. Now that it is highlighted, we will change the font.  On the top menu bar of MS 
Word (towards the left), you will see a pull-down menu with a name in it.  That is 
the name of the font.  Click on that menu and choose a different font.  You will 
notice that your text changes.  Some common fonts are Times New Roman, 
Arial, and Tahoma.   



Training Script II 
Page 5 

3. You can also change the size of the text by pulling down the numbered menu to 
the right of the font menu.  You can make the text larger or smaller with this 
feature. 

 
Changing the color: 

1. With the text still highlighted, we will now change the color of the text.  On the 
top menu bar of MS Word (right), you will see the capital letter ‘A’ with a solid 
color bar under it.  There will also be a small arrow next to it.  Click on the arrow 
to see your color choices. 

2. Move your mouse over the color you want to your text to be and click on it. 
 
Bold, Italicize, and Underline: 

1. On the same menu up top, you will see a capital ‘B’.  To make your text bold, 
click on the ‘B’ while the text is highlighted. 

2. To italicize, click on the ‘I’, which is next to the B. 
3. To underline , click on the ‘U’, next to the I. 

 
Questions? 
 
Justification: 

1. If you want to change the justification of the text (i.e. all the words to the left, 
right, centered, or full on the page), highlight the portion you want to change. 

2. Click one four buttons on the top menu (to the right of the U). 
 
Copy, Cut, and Paste: 

1. To copy text (so you can use it somewhere else), highlight a portion of it. 
2. Click on the Edit menu up top. 
3. Click on Copy (this will add your text to the Clipboard for later use). 

 
1. To paste this text, move the cursor to another part of the screen and click on the 

Edit menu again. 
2. Click Paste. 
* You will notice that an exact copy of what you just highlighted has just appeared on 
another part of the screen. 

 
1. To cut text (like copy, but it deletes the text from the original location), highlight a 

portion of it. 
2. Click on the Edit menu up top. 
3. Click on Cut (this will add your text to the Clipboard for later use and you can 

paste it just like you did with copy). 
 
Inserting Clip Art: 
Clip Art is a useful collection of pictures that is already stored on your computer.  You 
can insert these pictures easily into your document. 

1. Click on the Insert menu. 
2. Move your cursor over the Picture option and move it to the right and select Clip 

Art. 
3. A frame will open up on the right side of the screen and ask you for a search 

topic.  Let’s use the word ‘school’ as an example.  Type school and hit the 
Search button. 
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4. When the images appear, place your cursor where the want the image to be in 
your document.  Then, select a picture that you like and double click it. 

5. Once the picture is inserted, you can move it by clicking on it (and continue to 
hold the button) and dragging it. 

6. You can also resize it by: 
a. Clicking on the image once to reveal the black border. 
b. Then move the mouse over a portion of the border, click and drag that 

part to make it larger or smaller. 
 
Line Spacing: 
Line spacing is also a very useful because it makes the text easier to read.  Currently, 
your document is single spaced by default.  That means that there is one unit of space in 
between each line.  When you write a paper, the accepted standard is to double space 
it.  So, let’s change the line spacing.  For this to work, we need many lines of text.  If you 
do not have that many, please type some more or copy and paste some. 

1. Highlight the text you want spaced (usually the whole document). 
2. Click on the Format menu on at the top. 
3. Choose Paragraph. 
4. Make sure the Indents and Spacing tab is selected. 
5. In the third area down (Spacing) select the Line Spacing menu and choose 

Double (you will see that your text doubled in spacing) 
 
Grammar and Spell Checker: 
Another extremely helpful function in Word is the automatic grammar and spell checker.  
You may have noticed at some points that a red or green squiggly line has appeared 
under your text.  A red line means that you have spelled a word incorrectly or have 
added some extra space.  A green line signifies a grammatical error.  Usually if you right 
click on the underlined word(s), MS Word will offer some suggestions on how to correct 
your mistake. 
 
 
Questions? 


